
Felicitous Frames. PageMaker’s other layout
method is something to explore, not ignore

Desktop Science
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Did you jump? I’ve found that the word frames seems
to terrify longtime PageMaker users. Every other page-lay-
out application uses them—to get text or graphics onto a

page, you create a frame and then insert content into the frame. To many PageMaker
users, frames are the antithesis of PageMaker’s free-form text blocks and indepen-
dent graphics. To many creative people, PageMaker “feels” better than other page-
layout programs because it doesn’t use frames.

In this column, I’ll try to explain how to use frames and why they’re not something
to be scared of. Frames are just containers, and PageMaker, like every other page-lay-
out program, has always had containers to put elements in. In previous versions of
PageMaker, we couldn’t see or format these containers, but they were there nonethe-
less. Other publishing programs (FrameMaker, for example), made their containers
more obvious, let you control various aspects of their behavior or apply fills and

mes!
strokes to them, and called them frames.
In PageMaker 6.5, you can choose to work either way:

with the “invisible” frames that you’ve had in previous
versions of the program, or with frames you can modify
and format, as in other page-layout and drawing pro-
grams. And now, with frames, you can fearlessly mix and
match methods as it suits you—combining them in a
layout, or changing specific elements from one to the
other as you see fit.

Why use frames?
If you’re laying out a newsletter, newspaper, or maga-
zine, you’ll probably find frames easier to use than text
blocks. You can, for example, use a frame to hold a place
for a particular story, even if the text for the story isn’t
yet ready for layout. (To do this using text blocks, you’d
have to lay out a “placeholder” story, and then replace
the text of that story.)

If you work with a lot of sidebars, you can use a frame
to enclose the entire sidebar, and then apply a color to
the background of the frame. This is far easier than
drawing a rectangle behind a text block and then group-
ing the rectangle and the text block. I also think frames
provide a good way to work with tables, or with designs
that require headings or other text that must “hang”
outside the main column of text. And if your design
calls for angled columns of text, you’ll have a very hard
time producing it without using frames.

Like just about anything else in life, PageMaker’s
frames come with a set of “ground rules.”
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• There are two types of frames in PageMaker 6.5: text frames and

graphic frames. The content of a frame determines which type of
frame it is, and how it behaves.

• You can set graphic frames to automatically expand to fit the graph-
ics they contain.

• Text frames cannot automatically expand to fit the text they contain.
• You can’t paste a frame into a text block or into another text frame.
• You can link a series of text frames, just as you can link a series of

text blocks, but you can’t link a text block to a text frame, or link a
text frame to a graphic frame.

• Any PageMaker-drawn shape—excluding lines, but including open-
path polygons—can become a frame containing text or a graphic.

• Any text frame can be turned into a graphic frame, and vice versa.
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frame-drawing tools
Creating frames
To create a frame, you can draw it using any of the
frame-drawing tools or convert any PageMaker-drawn
object to a frame. To do this, select the object and
choose Change to Frame from the Frame submenu of
the Element menu (Ctrl + Alt + Shift + F in Windows or
Command + Option + Shift + F on the Macintosh).

You can add content—text or a graphic—to a frame
using any or all of the following methods.

Type text into a frame: Create a frame, select the text
tool, and click the tool inside the frame. When you start
typing, PageMaker will insert the characters you type
into the frame. You can also paste text from the Clip-
board into a frame.

Place content into a frame: Create a frame and se-
lect it. Choose Place from the File menu (Ctrl + D in
Windows or Command + D on the Macintosh) to dis-
play the Place Document dialog box. Select a file, select
Within Frame, and click OK. If you forgot to turn on the
Within Frame option, and find yourself staring at a
loaded place icon, you might think you have to cancel
the place operation, but you don’t—you can still place

the file inside a frame by clicking
the place icon on the frame.
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Join content to a frame: Select a text block or im-
ported graphic using the pointer tool, and press Shift
and select a frame. Choose Attach Content from the
Frame submenu of the Element menu (Ctrl + F in Win-
dows or Command + F on the Macintosh), and Page-
Maker puts the object inside the frame. Note that this
technique does not work for PageMaker-drawn objects.

Frame a story using a script: Click the text tool in-
side a text block, and then run the script named “Frame
Story.” (You’ll find this script in the Frame and Story
folder inside the Text folder in the Scripts palette.)
PageMaker draws a frame around all of the text blocks
in the selected story (it also preserves any overset text).
This is a great way of converting previously created text
blocks to text frames.

Sometimes you need to get the content out of a frame.
To do this, select the frame and choose Separate Con-
tent from the Element submenu of the Frame menu.
PageMaker separates the content from the frame and
leaves both the frame and the content on the page.

Setting frame options
Once you’ve added text or a graphic to a frame, you’ll
probably want to adjust how the content of the frame is
aligned, how the frame itself looks, and so forth.

Changing alignment. To display the options for a
frame, select the frame using the pointer tool, and then
choose Frame Options from the Element submenu of
the Frame menu (Ctrl + Alt + F in Windows or Com-
mand + Option + F on the Macintosh). See figure 1.

The options you see in the Frame Options dialog box
depend on the frame you’ve selected and on the content
of that frame. If you’ve selected a text frame, you’ll be
able to set the vertical alignment and the inset dis-
tances (the inner “margin,” or border) of the text inside
the frame (figure 1). If you’ve selected a graphic frame,
you’ll be able to specify that the frame should expand to
fit the graphic, or that the graphic should get clipped or
scaled to fit the frame (see the illustration on page 58).
You can also tell PageMaker how to align the graphic
horizontally and vertically inside the frame.

So how do you control the horizontal alignment of
text inside a text frame? It’s easy—you use paragraph
alignment, just as you would inside a text block. Since
this setting is paragraph-specific, you need to assign it
to individual paragraphs manually with the text tool or
automatically via paragraph styles; you can’t assign it to
the text frame per se.

Adjusting a frame’s appearance. You can ap-
ply fills and strokes to frames, too, just as you can
to any other PageMaker-drawn graphic. Select the
frame with the pointer tool, and then make
choices from the Fill and Stroke submenus of the
Element menu or the Fill and Stroke dialog box, or
use the Colors palette’s controls to apply colors to
the frame’s fill or stroke.

When you apply a stroke of None to a frame, the
frame’s border displays on screen as a one-pixel-
wide gray line even when you deselect the frame



To link text frames together as you create them, hold down Ctrl (Windows)

or Command (Macintosh) as you draw the frames. Each new frame you create

will be linked to the frame you drew before it. Please note that this works only

with “regular” frames (frames created with a single click-and-drag of any frame

tool), not with irregular polygons you create by clicking to draw each line

segment. Also note that in PageMaker for Windows before version 6.52, you

couldn’t link frames while you created them.

To navigate your linked text frames quickly and easily, click your text

tool in the text and use the arrow keys to move up and down; PageMaker will

automatically jump to another page if necessary. Try that with text blocks!

link icon

figure 2
(though, of course, it’s a nonprinting line). To hide this
line, turn off PageMaker’s guides.

Linking text frames
Like text blocks, text frames can be linked together to
form a threaded story. To link text frames, click the
lower windowshade handle of the first text frame (which
probably contains text, but might not). PageMaker
changes the cursor into the link icon (figure 2). Click the
link icon on the next text frame. PageMaker links the
two text frames.

You can link text frames even if the frames aren’t on
the same page or spread. Click a windowshade handle,
and then, after PageMaker displays the link icon, turn to
the page containing the text frame you want to link to.
Click on the frame, and the two text frames are linked.
You can click the page icons, move the scroll bars, and
use keyboard shortcuts without losing the link icon
(just as you can when you’re placing text and the cursor
is a place-text icon).

To unlink a text frame from the preceding frame, hold
down Ctrl + Shift (Windows) or Command + Shift (Mac-
intosh), and click the upper windowshade handle of the
frame. PageMaker breaks the story where you clicked,
flowing any text contained in text frames following the
point at which you clicked back into the text frames pre-
ceding that point.

Creating angled columns
An angled column is an effect that’s difficult to get using
text blocks, but easy to produce using text frames.
Here’s how you do it.
1. Double-click the polygon tool (not the frame polygon

tool). PageMaker displays the Polygon dialog box.
Type 4 in the Number of Sides field, make sure that
the Star Inset field is set to 0 (zero), and then click OK
to close the dialog box.

What are we doing? Ultimately, we’re after an editable
rectangular frame. But rectangles created with the rect-
angle tool can’t be edited, so we’re going to use the poly-
gon tool to create a rectangle instead, and we’re chang-
ing the settings via the regular polygon tool because
We’ve created an editable polygon to

achieve this angled-column effect, but you

could also create a polygon of any shape

and then convert it to a frame.
those settings carry over to the frame polygon tool.
2. Set up guides to define a rectangle the width and

height of the desired column. Don’t worry about the
angle of the column—we’ll come to that later.

3. Select the frame polygon tool from the toolbox and
draw a rectangular frame that’s the height you want
the angled column to be.

4. Double-click the frame to edit its shape. Drag the two
bottom vertices of the frame to create the angle you
want. You’ll have to move them one at a time. You
might want to watch the Control palette as you move
the vertices—that way, you’ll be able to move them
the same distance.

5. Attach text to the frame.
If you want more than one angled column, duplicate the
first column before you add text to it, link the columns
together, and then attach text to the column.
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Frames as placeholders for graphics
Traditionally, many of us have used rectangles as place-
holders for graphics, and then replaced them with our
imported graphics. The trouble is that the incoming
graphic scales, or stretches, to fit the area of the place-
holder. The result? I’m sure you’ve seen newsletters full
of distorted graphics—what I call the “funhouse mirror”
effect. How can you use a graphic placeholder to make
sure that the incoming graphic fills the area you’ve de-
fined using a placeholder, but doesn’t get distorted?

It’s easy—use a frame. Draw the frame, and then open
the Frame Options dialog box. Select the Clip Content
to Fit Frame option (I leave the various alignment op-
tions up to you). When it’s time to place a graphic, select

the frame and choose Place from
the File menu.  Select a file, select
Within Frame, and click OK.
PageMaker crops  the graphic so
that it fills the frame.
If the graphic is larger than the
frame, you can pan the graphic inside
the frame using the cropping tool. Posi-
tion the cropping tool over the image,
and then drag to change your view of
the image inside the frame. Be careful,

though—you can’t undo this drag. If the image is
smaller than the frame, you’ll probably want to detach
it, scale it so that it’s larger than the frame, and then at-
tach it to the frame again. Either way, you’ll avoid the
“stretched and squashed” look.

Adding graphics to frames using a script
As I mentioned previously, PageMaker 6.5 includes a
script for turning selected text blocks into text frames.
But suppose you want to put all of the hundreds of
graphics in your catalog inside graphic frames—maybe
you want to put a keyline around each image, and this is
the easiest way. To do that, you’ll have to draw a frame
for each graphic, select the graphic and the frame, and
then attach each graphic to its frame.

Or will you? I’ve written a script that will save you the
trouble. You don’t need to know much about Page-
Maker’s scripting language to use it; just type the script
in the right place and you’ll have a handy tool you can
use over and over again.
1. Display the Scripts palette, if it’s not already visible
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(choose Show Scripts from the Plug-in Palettes sub-
menu of the Window menu).

2. Choose New Script from the Scripts palette’s pop-up
menu. PageMaker asks you to name the script file.
Enter a name you can remember (such as “Frame
graphics”) and save the script file somewhere in
PageMaker’s Scripts folder. Click Save, and Page-
Maker displays the Script Editor window.

3. Type the following script in the window. Click OK
when you’ve finished editing the script. The script ap-
pears in your Scripts palette.

--This script puts all of the imported

--graphics in the current selection inside

--graphic frames. This script doesn't

--handle transformed (i.e., rotated) objects

--particularly well.From Olav Martin

--Kvern's "Desktop Science" column,

--Adobe Magazine, Spring 1998 issue.

getselectidlisttop>>numberOfObjects,objectList

loop counter = 0, numberOfObjects

set objectList>>nObjectID, nMaskID,

nGroupID, nDrawNumber, objectType,

bTransformed, bLinked, x1, y1, x2, y2, ulX,

ulY, lrX, lrY, objectList

if (objectType # (6,8,9,10,11,14))

box x1,y1,x2,y2

toggleframe

framecontentpos 1,1,1,1

selectIDextend nObjectID

attachcontent

endif

endloop

deselect

Note: The text highlighted in blue (above) is one long
line of code; don’t press Return until you’ve typed it all.
4. Select a series of (unframed) graphics. You can actu-

ally use Select All to select everything on a page—the
script will put frames only around the imported gra-
phics and groups it finds in the selection.

5. Double-click the script in the Scripts palette. If you’ve
typed everything correctly, PageMaker will place
frames around all of the graphics you selected.

The final frame
As a faithful follower of PageMaker, I find the inclusion
of frames in PageMaker 6.5 a beautiful and moving rec-
onciliation of competing views of page layout. We can
have it both ways—the fluidity of free-form layout with
text blocks and graphics, and the rigidity and control
offered by frames. All in one package.

Please feel free to drop me a line care of the magazine
or at okvern@ix.netcom.com. I’d love to hear from you,
and your comments help me make this column better. I
can’t always reply quickly, but I read and think about
every message. Thanks! ◆

Olav Martin Kvern is a software developer, writer, de-
signer, and illustrator, and is the author of the Real World
PageMaker and Real World FreeHand books.


